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RX110, RX111, RX113, RX231 Group ROLAN2670EJ0101
RX Driver Package Ver.1.01 Oct 31, 2015

Introduction
This document is the RX110, RX111, RX113, RX231 Group RX Driver Package User’s Manual, version 1.01.

This User’s Manual describes basic structures, features and usage of RX Driver Package applications, and about the
sample application program using the FIT modules included in this package.

Target Device

RX110M Group (Renesas Starter Kit RX110)
RX111M Group (Renesas Starter Kit RX111)
RX113M Group (Renesas Starter Kit RX113)
RX231M Group (Renesas Starter Kit RX231)

When using this application note with your product, careful evaluation is recommended.

And when using this application note with other Renesas MCUSs, careful evaluation is recommended after making
modifications to comply with the alternate MCU.

Related Documents

e RX Family Board Support Package Module Using Firmware Integration Technology (ROLAN1685EU)
e Firmware Integration Technology User’s Manual (RO1AN1833EU)

e RX Family Adding Firmware Integration Technology Modules to Projects (ROLAN1723EU)

o RX Family Adding Firmware Integration Technology Modules to CS+ Projects (ROLAN1826EJ)

e The User’s Manual provided with the RX Driver Package Application.
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1. Overview

1.1 Applicability

This User’s Manual applies to the RX110, RX111, RX113, RX231 Group RX Driver Package, version 1.01

1.2 Operating Environment
This package runs under the operating environment described below.

Table 1-1 Operating Environment (RX110)

Microcontroller

RX110 Group

Evaluation board

Renesas Starter Kit RX110

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20

Table 1-2 Operating Environment (RX111)

Microcontroller

RX111 Group

Evaluation board

Renesas Starter Kit RX111

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20

Table 1-3 Operating Environment (RX113)

Microcontroller

RX113 Group

Evaluation board

Renesas Starter Kit RX113

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20

Table 1-4 Operating Environment (RX231)

Microcontroller

RX231 Group

Evaluation board

Renesas Starter Kit RX231

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20
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2. About RX Driver Package

The RX Driver Package is a software platform (framework) that combines the following modules to be required for
development in a single package. Since the package contains multiple modules, you can start developing immediately
without having to obtain each module separately.

Board Support Package (BSP) module

FIT peripheral function modules (free version)

FIT middleware modules (free version)

FIT interface modules

You can develop the user application layer with ease by using the Sample Application Program (RX Driver Package
Application) which utilizes the RX Driver Package.

2.1

System Structure

The figure below shows the system structure of the RX Driver Package.

[

Interface ][ Middleware ]

[

Device
Driver

e ]

Standard
components

RX Driver Package Application

e2 studio
project
- g *
RX Driver POSIX Wrapper ]
FIT Module)
Package ¢
9 —1 | — | |
Middleware Middleware Device Driver &2 studio
L (FIT Module) (FIT Module) (FIT Module)
1 T ] !
Device Driver Device Driver Device Driver Device Driver CC-RX
(FIT Module) (FIT Module) (FIT Module) (FIT Module) -
1 1 | | _occ |
RTOS Wrapper * mm—————m
(FIT Module) L__IAR |
1 |
{ RTOS i
] (uITRON, FreeRTOS, etc) ! Support
+ 4 | I tool
Board Support Package
(BSP Module) y
| | | | L
e —————— R x \
! Third party evaluation \ Renesas evaluation E1 E20
1 board H Board ! )

* Items marked with an asterisk are under development.

Figure 2-1 System Structure
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2.2 RX Driver Package Features
The RX Driver Package has the following features.

(a) Select necessary modules and start developing immediately the application program

You can easily build a system simply by selecting the modules you need from the package. After that, all you have to
do is develop the application program.

*1 Japanese edition only.

User System
(Server System)

=)

Figure 2-2 An example of system build

(b) Freeto use
All the modules included in the RX Driver Package can be used free of charge. Free versions of middleware modules
such as TCP/IP and file system are included.

(c) Can upgrade to paid versions of modules

The free versions of modules in the RX Driver Package can be replaced with commercial (paid) versions. By using a
commercial (paid) version, all the functionality of the module will be available, as well as support about a commercial
version.

(d) Check operation including user application

The RX Driver Package Application is provided as a sample user application that uses the RX Driver Package. The RX
Driver Package Application consists of programs for operating each module in the RX Driver Package, and the project
files for building the programs. It enables you to start checking the operation of your user application immediately.
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3. Structure of the RX110, RX111 , RX113, RX231 Group RX Driver Package

3.1 Folder Structure
The folder structure used in this package is shown below.

When the ZIP file for this package is downloaded from the Renesas web site and decompressed, a folder of the same
name will be present and it will contain a FITModules folder, a reference_documents folder, and this document.

The FITModules folder contains the FIT modules for the modules shown in Table 3-1(as ZIP files and XML files).

The reference_documents folder contains the documentation for using this package in various development

i

RX110, RX111, RX113, RX231 Group RX Driver Package ZIP file
(an_r01an2670ej0101_rx.zip)

!

an_r01an2670ej0101_rx_fit

|_PoF |
FITModules reference_documents Application Note

(r01an2670ej0101_rx.pdf)
l | (This document)

! | ! !
(WY \ = =

FIT Module XML FIT Module ZIP file Adding Firmware Integration Adding Firmware Integration
(r_#=%_y* *% yml) (r_#*%_y* *% z7ip) Technology Modules to Technology Modules
Projects to C5+ Projects

(r0lanl723eu****_rx pdf) (r0lan1826ej****_rx.pdf)

Figure 3-1 Folder Structure of the RX110, RX111, RX113, RX231 Group RX Driver Package
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3.2 Module Structure
The figure below shows the types and structure of the FIT modules included in this package.

*1 Japanese edition only.

Figure 3-2 RX110, RX111, RX113, RX231 Group RX Driver Package FIT Module Structure
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3.3

FIT Modules

The table below lists the FIT modules included in this package.

Table 3-1 RX110, RX111, RX113, RX231 Group RX Driver Package FIT Modules

Type Module FIT Module Name R R R R Rev.
X X X X
11 1 2
1 1 1 3
o 1 3 1
Board Support Board Support Package (BSP) r_bsp v v v v 301
Package
Device Driver  Low Power Consumption (LPC) r_Ipc v v Vv - 130
Device Driver  Battery Backup (VBATT) r_vbatt - - - v 101
Device Driver  Interrupt Controller (IRQ) r_irg_rx v v v v 170
Device Driver  Data Transfer Controller (DTC) r_dtc_rx v v v v 203
Device Driver ~ DMA Controller (DMAC) r_dmaca_rx - - - v 103
Device Driver  1/O Ports (GPIO) r_gpio_rx v v v v 170
Device Driver  Multi-Function Pin Controller (MPC) r_mpc_rx v v v v 170
Device Driver ~ Compare Match Timer (CMT) r_cmt_rx v v v v 260
Device Driver  Real-Time Clock (RTC) r_rtc_rx v v v v 240
Device Driver  Independent Watchdog Timer (IWDT) r_iwdt v v v v 150
Device Driver  Serial Communications Interface (SCI: r_sci_rx v v v v 170
Asynchronous/Clock Synchronous)
Device Driver  Serial Communications Interface (SCI: Simple r_sci_iic_rx v v v v 170
I2C Bus)
Device Driver  1°C Bus Interface (RIIC) r_riic_rx v v v Vv 170
Device Driver  Serial Peripheral Interface r_rspi_rx v v v v 140
Device Driver  Serial Peripheral Interface (RSPI: Device Driver r_rspi_smstr_rx v v v Vv 1.09
for Serial Memory Control)
Device Driver  USB Basic Firmware r_usb_basic v v v v 101
Device Driver  USB Host Mass Storage Class r_usb_hmsc v v v v 101
Device Driver ~ USB Host Communication Device Class r_usb_hcdc v v v v 101
Device Driver  USB Host Human Interface Device Class r_usb_hhid v v v v 101
Device Driver  USB Peripheral Mass Storage Class r_usb_pmsc v v v v 101
Device Driver  USB Peripheral Communications Device Class r_usb_pcdc v v v v 101
Device Driver  USB Peripheral Human Interface Device Class r_usb_phid v v v v 101
Device Driver  IrDA Interface (IrDA) r_irda_sci - - v - 101
Device Driver ~ CAN Module (RSCAN) r_can - - - Vv 100
Device Driver  12-Bit A/D Converter (S12AD) r_sl2ad_rx v v v v 210
Device Driver  D/A Converter (DAC) r_dac_rx v v v 250
Device Driver  Flash Memory (Flash API) r_flash_rx v v v v 130
Device Driver  Serial Sound Interface (SSI) r_ssi_api_rx - - v v 120
Device Driver  LCD Controller/Driver (LCDC) r_lcdc - - v - 1.00
Device Driver  Unique ID Read r_uid v v v - 100
Device Driver  Byte Queue Buffer (Data Management) r_byteq v v v v 150
Device Driver  Long Queue Buffer (Data Management) r_longq v v v v 150
Interface POSIX Wrapper I_posix v - 1.01
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Type Module FIT Module Name R R R R Rev.
X X X X
11 1 2
1 1 1 3
o 1 3 1
Middleware TCP/IP M3S-T4-Tiny for Embedding r_t4 rx v v - - 202
Interface Embedded TCP/IP M3S-T4-Tiny Socket API r_socket v v - - 122
Module
Middleware DHCP client using the embedded TCP/IP M3S- r_t4_dhcp_client.rx v v - - 1.03
T4-Tiny Module
Middleware DNS client using the embedded TCP/IP M3S- r_t4_dns_client_rx v v - - 1.02
T4-Tiny Module
Middleware FTP server using the embedded TCP/IP M3S- r_t4_ftp_server_rx v v - - 1.03
T4-Tiny Module
Middleware Web server using the embedded TCP/IP M3S- r_t4 http_server rx vV - - 104
T4-Tiny Module
Middleware Sound playback system and compression r_s2_rx - v v v 303
system (original ADPCM codec)
Middleware M3S-TFAT-Tiny (FAT file system) r_tfat_rx - v v v 304
Interface M3S-TFAT-Tiny Memory Driver Interface r_tfat_driver_rx - v v Vv 102
Module
Middleware Simple 12C Module for EEPROM Access r_eeprom_sci_iic v v Y - 130
Middleware I12C Bus Interface (RIIC) Module for EEPROM r_eeprom_riic v v v - 140
Access
Middleware SPI Serial EEPROM Module r_eeprom_spi v v v v 232

Note: This package includes the M3S-T4-Tiny (TCP/IP protocol stack library) of evaluation version. For the
commercial version, please go to the below URL.
http://www.renesas.com/mw/t4
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4. Usage Procedures

The RX Driver Package allows programs to be easily constructed by using the FIT plugin included in e studio. The
remainder of this section presents a simple usage example using e? studio. To use CS+, see the document “RX Family
Adding Firmware Integration Technology Modules to CS+ Projects (RO1AN1826EJ)” included in this package.

4.1 Environment Used

The RX231 is used as the target microcontroller and the Renesas Starter Kit RX231 is used as the target board. If a
different environment is used, replace the specifics used in the example with the ones for that environment as you read.

4.2 Install RX Driver Package in e? studio
Install the FIT modules in the RX Driver Package into e? studio.

1. Decompress the downloaded file an_r01an2670ej0101_rx.zip into an arbitrary directory.
2. Open the folder that was decompressed and open the FITModules folder in that folder.

3. Select all the files in the FITModules folder and click Copy in the Edit menu.

[E=8 Eol 57
@Cj" » » FTModules » v [ 42 ||| Search FiTModutes p
File| Edit [Tiew Iools Help
QOrganize v Include in library = Share with = New folder i - il 9-
¢ Favorites = ags ¥ e M [ pois, vl D (R ) .
" =t Bl .l i Select all files and click
4 Ml Desktop i_iig ol e Ryl bt s il . .
=5 Libraries [ sy e oLty - Copy in the Edit menu.
B & e S T p— »Bavy_m_el. T]op e s R ]
1% Computer 4 L g i el Lo H
€ Network K. e 1.5
8 Control Panel ol B g o el I =y Sl 1_tean_apul_p
5] Recycle Bin din i oy el 0 s o e n_sl T
* J ooy <L o T [
ar 1 - . A ”
FITModules iy C = : | e et i g H_iy
reference_documents [T X, Ty ey P i rui ol ol
- i _n_ YT IY FE - [ i e
ey 1.5 e pokc m s D0 w1 e e H g o
84 ;lem:s
I
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4. Open the 2 studio install folder (Usually, this will be c:/Renesas/e2_studio.) and open the FITModules folder in
that folder.

5. Click Paste on the Edit menu.
The e? studio FITModules folder will be copied to the FIT modules.

(=)0 )=]

@\—;}vl » Computer » Local Disk (C:) » Renesas » €2 studic » FITModules » - |+,l| Search FiTModules jel Open the FlTMOdU|eS
e ¢ |rem—teoi—tic folder and click Paste
Organize v [ Open  Newfolder e ] @ on the Edit menu.

g oo i - - . The folder will be copied.
w e : — —r
Renesas — L z
&2_studio 1 5
DebugComp a 3 =
Drivers o ) = E
eclipse - - = i . "
etc ] N n
FITModules : B =l ]
internal - < . r
86 items selected
@ Show more details.

4.3 Application Creation
In this section, create a simple application that drives an LED.

4.3.1 Create a Workspace and a Project
First, create a new workspace and a new project.

1. Start e? studio.

2. Enter an arbitrary workspace folder in the displayed dialog box and click OK.
Workspace Launcher @

Select a workspace

e2 studic stores your projects in a folder called a workspace,
Choose a workspace folder to use for this session,

Enter a workspace

Workspace | | [—erowse—] folder
[7] Use this as the default and do not ask again
Ok |H—*canee—] Click OK.
RO1AN2670EJ0101 Rev.1.01 Page 11 of 27
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3. When the following window is displayed, click Workbench.

File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help

3 @ Welcome 52

— Click Workbench.

4. When the workbench has started, select New from the File menu and click C Project.

Edit Source Refactor

Mavigate Search Project Run  Window Help

Click here.

Mew Alt+Shift+M » Renesas FIT Module
Open File... | | C Project I
-~ 5
Close Ctrl+W G+ Project
o . N -
A T Makefile Project with Existing Code
% Project..
2] Save Ctrl+5 ) :
E:“ﬂ Save Ae.. Convert to a C/C++ Project (Adds C/C++ MNature)
[ SaveAl Ctivshiftes |8 Source Folder
— % Folder
E‘f Source File
[T [ HeaderFile
™ Rename.. = |j File from Template
& Refresh F5 @ Class
Convert Line Delimiters To 3 £F Task
=] | P CiP 1 =4 Other.. CtrieN
Switch Workspace 3
Restart
£2y Import..
B3 Export.
Properties Alt+Enter
Exit

Il
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5. Enter the project name. For the project type, click Sample Project under Executable (Renesas). For the tool chain,
click Renesas RXC Toolchain. After making these settings, click Next.

C Project I?‘@

C Project p—

Create C project of selected type

Project name| led_sample Enter the

Use default location pI’OJeCt name.

Cihsample_workspace\led_sample Browse...

Create Directory for Project

Project type: Toolchains:
Executable (Renesas) KPIT GMUARM-RZ-EABI Toolchain
® Sample Project PG HUREFE-ELFFootchain Click here.
Static Library (Renesas) KPIT GMURX-ELA Teolchain
@ Sample Project KPIT GNUSH-ELR Toolchain
Debug-Only Project Renesas RXC Tooichain'
Executable

Renesas SHC Toolchain
Executable (IAR])

Shared Library

Static Library

V&00 Standalone Executable (Green Hills)
VB00 Standalone Static Library (Green Hills)
V800 ThreadX Executable (Green Hills)
Makefile project

] | m r

Show project types and teclchains only if they are supported on the platform

@ <gack [ Med> |[ Finsh |[ Cancel |

6. Select the target. Click the “...” button under Target Selection and select R5SF52318AxFP. After making these
settings, click Next.

lef| C Project Lo [0 s
e2 studio - Project Generation —
Select Target Specific Settings
Toolchain Version : [vZ.CIl.UU V] P
Debug Hardware: [E]. v] ‘%‘1,
%)
Data endian : [L\ttlefendian data '] g‘“ C“Ck here and
&,
Select Target:
9 7 select
R5F52318AxFP.
Select Configurations:
Hardware Debug : Debug using hardware
Debug using Simulator @ Debug using simulator
[] Release (no debug) : Project without any debug information
Build configurations will be created in the project only for the selected debug mode
options, however by default the project will be built for the active configuration i.e.,
first configuration selected from group. Based on the device selection you made
(RX600) the debug hardware (E1) and debug target (RSF56107VxFP), debug
cenfiguration will be automatically created for you,
3 3 .. 1
@ <Back ! —] Click here.
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7. Set the check box of “Use FIT module” and click Next here. ‘
le?| C Project =3 B =)

e2 studio - Project Generation

Code Generator and FIT Settings

Use Peripheral code Generator

[t P mecie | {DovmEeT T oS B check box

The e2 studie peripheral code generator automatically generates programs (device drivers) for MCU peripheral functions (clocks, timers, serial
interfaces, A/D converters, DMA controllers, etc.) based on settings entered via a graphical user interface (GUI). Functions are provided as application
programming interfaces (APIs) and are not limited te initialization of peripheral functions.

Conventionally, the information "CMCU initial settings”, "How to define a target board", "File configuration’, "Names of functions’, "Common interface
with user application” etc; has in many cases varied by sample code, so changes needed to be made to sample code when embedding into a user
application. With FIT, there are rules for this information, so each sample code can be embedded inte a user application with ease. Alse, the peripheral
function drivers and middleware which support FIT have a common interface with user applications. This makes it easy to port user applications when
migrating between RX¥ microcontrollers.

[ User Application J
Middleware
FIT
G RTOS
Device Diiver Device Driver (BSP)

( MCU )

(‘?J\' ’ < Back Next = [ Finish 1 [ Cancel ] CI|Ck here.

T

8. Simply click Next here.
C Project ?@

e2 studio - Project Generation

Select Additional CPU Options

Select Additional CPU Options:

Round: [Nearest vl
Precision of Double: [Singla precision vl
Sign of Char: [Unsigned vl
Sign of bit Field: [Unsigned -
Allocate from Lower Bit [Lower bit 'l
Width of Divergence of Function: [24 Bit vl

Specify Global Options:

|| Denarmalized number allowed as a result
[] Replace from int with short

[T Enum size is made the smallest

[] Pack structures, unicns and classes
[[use try, throw and catch of C++

| Use dynamic cast and typeid of C++

@ < Back L Click here.
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9. Simply click Next here.

ol C Proect = (===
e2 studio - Project Generation —
Global Options Settings |

Patch code generation [None Vl
Fast interrupt vector register: [None Vl
ROM: [None Vl
RAM: [None VI

Address (H): 00000000

Address Register: [ Mone - I

) I 11 P H

@J [ < Back I[T T arree— Click here.
10. Simply click Finish here.
e C Project
e2 studio - Project Generation
Standard Header Files |

Library configuration: | C(C99)

Select Header Files:
runtime : Runtime routines (Checked and disabled by default)

[ ctype.h : Character classification routines

[T math.h : Mathematical /trigonometric operations(double-pracision)

[T mathf.h : Mathematical /trigonometric operations(single-precision)

[T stdarg.h : Variable argument functions

[#] stdio.h : Input/Output

[¥] stdlib.h : General purpose library features

[¥] string.h : String handling operations

[Tlios(EC++) : Input/Output Streams

new(EC++) : Memory allocation and deallocation routines

[ complex(EC++) : Complex number operations

[ string(EC++) : String manipulation operations

[Tl complex.h(C99) : Performs complex number calculation

[ fenv.h(C98) : Sets floating point environment

[Clinttypes.h(C99) : Converts integer type format

[Tl wehar.h(Ceg) : Performs wide character

[TJwetype.h(C99)  : Performs wide character conversion

~ - .

@ Nex | H——==a—— Click here.
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11.Click OK. The project will be generated.

Surnmary [ |
Project Summary:
———————— PROJECT GEMERATOR -------- -
PROJECT NAME : led_sample
PROJECT DIRECTQRY : C\WerkSpace\RDP\led_sample
CPU SERIES :
CPUTYPE:
TOOLCHAIM NAME : Renesas RXC Toolchain
TOOLCHAIN VERSION :

GEMNERATION FILES :

C:\WorkSpace\RDP\led_sample\src\led_sample.c
Main Program

4 3

Click OK to generate the project or Cancel to abort,

[ 0K ” Tancel ] Click here.
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4.3.2 Install the FIT Modules with the FIT Plugin.
Install the required modules with the FIT plugin into the created project.

Here, install the BSP module (r_bsp) and the compare match timer driver (r_cmt_rx).

1. Inthe Renesas Views menu, select e2 solution toolkit and click FIT Configurator.

7] C/Cer - e2studio
File Edit Source Refactor Mavigste Search Project [RenesasViews | Run Window Help

FE | -&~- s i s oo D R R m s
Code Generator »

ng.oje:tsxplorer b3 BE% ¥=0 Debug =5

> (R e ] €2 solution toolkit r»__;-y FIT Configurator Click here.
Partner 05 » | EL  Optimization Assistant
Renesas 05 » | @ Smart Browser

L Smart Manual

[ Problems 52 Tasks Console operties Vemory Usage [fg] Stack Analysis
0 items
Description Resource Path Location Type

(5 led_sample

2. Inthe FIT Configurator tab,
Select the created project with Project to Add FIT Module to.
Next, select RX231 under Group and select RSKRX231 from Target Board.
Next, click r_cmt_rx in the module list and click Add Module >>.

[E=8 =R 5|

Quick Access || g | [[@C/Cer ]

2= Qutline 52 skeTa.. = O

An outline is not available.

AN =0 M Ee AT = g

[eF C/Cov - e2 studic

File Edit Source Refactor Mavigate Search Project RenesasViews Run Window Help

i [ @R i # OG- G- G- -0 G-i® V-0 LT
[ Project Explorer 22 = B8 =0
BE% ~

> =5 led_sample [HardwareDebug]

[ Problems J=| Tasks [ Console [ Properties Memory Usage [ig] Stack Analysis @ Smart Browser [l FIT Configurator 53

(=& ]le=]
Quick Access || B |[Eere=)
OF Outline 53 ake Targe = 8

An eutline is not available.

5] Generate Code ¥ = 0

Name of the project to add FIT modules: || led_sample

ol

s [ e gelect the target board.

Available Modules

Select the project.

Selected Modules

Modules Version  Descrigtion || Medules Version
r_bsp 300 Board Support Packages. El

tbyteq 150 Byte-based circular buffer ibrary.

rcmb o 110 CMTW Driver L.

e 260 Simple CMT driver for creating timertick. _| Select this item.

e 250 Digital-to-Analog Converter driver

r_dmaca 103 DMACA driver

rdtc_nc 203 DTC driver

r_eeprom_spi 232 Renesas RIEX2500c series Serial EEPROM control software RX Driver Package

the o e Ethcenct Neber ]
=rememae- Click here.
Detsils

Dependency: r_bsp version(s) 290
This module creates a timer tick using a CMT channel based on a frequency input by the user.

RO1AN2670EJ0101 Rev.1.01
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3.

In the Console tab,
In the current example, the r_bsp having a dependency with r_cmt_rx is also added at a time. *
Click FIT Configurator again.

*: The r_bsp version defined in r_cmt_rx is 2.90 version or later. As r_bsp version packaged in the RDP is 3.01,
the Warning (W0000001) occurs on the console screen. However, as the Warning has no impact on adding the
module, it can be ignored.

|# Problems | Tasks | & Console i2 [C] Properties Memory Usage [tg] Stack Analysis & Smart Browser [T *FIT Configurator =" | s} *Ci~>= 0O

FIT Configurator Conscle

Meeeeeel: The following dependencies have been added for the following module: -
e & Click here.

= — = L B
wWeeeeesl: The follewing dependencies versicns are mismatched:
r_cmt_rx: r_bsp version(s) 2.98@

This is no problem to ignore this warning.

4. Check r_bsp and r_cmt_rx are added in Selected Modules. The mark “® on r_cmt_rx indicates occurrence of the

Warning explained in the above 3.

Then, click Generate Code.

® ! Problems J= Tasks & Conscle [T Properties [l Memory Usage Stack Analysis @ Smart Browser 7L *FIT Configurator 53 % Generate Code ~ =
P y 9 Iy ¥ P 9
\
MName of the project to add FIT modules: [Ied_sample \ v]
3

Target Board :} Advanced Filters... CIICk here
Available Modules Selected Modules
Modules Version  Description “ || Medules Version
r_bsp 3.00 Board Support Packages. E r_bsp 3.00
r_byteq 1.50 Byte-based circular buffer library. o), r_cmt_ne 2.60
r_cmitw_rx 110 CMTW Driver
r_cmt_m 2,60 Simple CMT driver for creating timer tick. \
r_dac_rx 2.50 Digital-to-Analog Converter driver Check here
r_dmaca_mx 1.03 DMACA driver
r_dte_mx 2.03 DTC driver
r_eeprorm_spi 232 Renesas R1EX2500 series Serial EEPROM control software RX Driver Package
¢ other re 107 Ethernet Nrier ol
Add Medule > << Remove Module
Details

Dependency: r_bsp version(s) 2.90
This module creates a timer tick using a CMT channel based on a frequency input by the user,

RO1AN2670EJ0101 Rev.1.01 Page 18 of 27
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5. Click OK with changing anything.

® FIT Generation - Summary | 3 |
Fellowing modules will be installed: -
r_bsp
r_cmt_nc

Following include paths will be added to project setting:
/${ProjMame}/r_bsp

/8{ProjName}/r_config

/8{ProjName}/r_cmt_rx

/8{ProjName}/r_cmt_m/src

Click OK to continue, Cancel to go back

[ oK l|{ e ] Click here.
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4.3.3 Create an LED Driving Program
Create a program that toggles the LEDO on/off state every 0.5 seconds using the compare match timer.

Open the file src/(the project name).c and modify it as shown below.

src/(the project name).c

#include "platform.h"
#include "r cmt rx if.h"

/* LED Currently status */
uint32 t ledstatus = LED_OFF;

void call back(void *pdata)
{
if (ledstatus == LED OFF)
{
/* Turn ON the LEDO If the status is LED OFF */
LEDO = LED_ON;
ledstatus = LED_ON;
}
else

{
/* Turn OFF the LEDO If the status is LED ON */

LEDO = LED OFF;
ledstatus = LED OFF;
}
}

void main (void)

{
uint32 t cmt ch;

/* LEDO off */
LEDO =LED OFF;
/* Create of 0.5 second(2Hz) cyclic timer. */
R CMT CreatePeriodic (2, &call back, &cmt ch);

while (1) ;

RO1AN2670EJ0101 Rev.1.01
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434 Build and Try Running the Program
Build the program just created and verify that it runs.

1. Click Build Project on the Project menu.

2 studio
Search | Project | Run  Window Help
E cﬁ : Open Project 5 - @
Close Project
= 08
— | lap Build All Ctrl+B o poees
Build Configurations L2 LED.S .
Build Project }— Click here.
- - E LEDB Ii
Build Working 5et 3 0
Clean... = LED.Oh
Build Automatically
Renesas Quick Settings Alt+Q R
Update All Dependencies Alt+D  D_OFF:
Make Target y | = LERLOE
C/C++ Index 3
Properties
%50 uinE32.5, cmt_ch;
51
52 /* LED® off */

2. When the build completes, the following will be displayed in Console view.

E_\ Problems 2 Tasks B Console 52 £ Properties Memory Usage |E| Stack Analysis

CDT Build Console [led_sample]

C:\Renesas\E22FCB~1\DEBUGC~1\RX\RX_CON~1.EXE led_sample.abs led_sample.x
Loading input file led_sample.abs

Parsing the ELF input file.....

25 segments required LMA fixes

Converting the DWARF information....

Constructing the output ELF image....

saving the ELF cutput file led_sample.x

'Build complete.’
17:31:13 Build Finished (took 195.594ms)

4 ]

3. Click Debug Build on the Run menu.

Project Window Help

g’;gj;% Run CtrieF1l [ 6 =)

%, Debug F11
- Run History »
i Run As 3
34
35 Run Configurations...
36 status i
37 Debug History 4
38
39 Debug As » ]
4@ Debug Configurations... }— CIle here.
42 Teggle Breakpoint Ctrl+Shift+B status
:f Teggle Line Breakpoint
45 Toggle Method Breakpoint
ff Toggle Watchpoint
ag| = Skip All Breakpoints
f: Remove All Breakpoints
=1
51 Breakpoint Types »

@, External Tools 3

[Z Problems %] Tasks | E] Conscle 32 | =1 Properties Memory Us
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4. Click “ under the Renesas GDB Hardware Debugging and click led_sample HardwareDebug. Click the
Debugger tab and click Connection Setting.
Modify EXTAL Frequency to be 8.0000 and change Provide Power from Emulator to No *.
When these changes have been made, click Debug.

Note : This is setting when using an external power supply. When supplying power from the emulator, select Yes.

Debug Configurations @
Create, manage, and run configurations
% @ 1
=X | B 5 Name: led_sample HardwareDebug
type filter text [El Main| % Debugger . I Startup| s Source| = Comman
[£7 Debug-only - )
G- G0E Hard Debuagi Dabug haed £ x| TargetDev C“Ck here
[£¥ GDB Simulator Debugging (SH, RLT
P 1
sy GHS Local C/C++ Laungh ‘ GDB Sattmgsl‘ Cennection Settings ”Dehug Tool Sattmgs|
t# Renesas GDB Hardware fittach 2 Clock
Renesas GDB Hardware Pebugging Main Clock Source EXTAL g )
[£7] led_sample HardwareDebug Extal Frequency(MHz] |: L Modlfy to be
» [E9 Renesas Simulator Debugging (RX o Permit Clock Source Change On Writing Inte Yes - 80000
4 Connection with Target Board
Emulater (Auta) [
Connection Type JTag -
ITag Clock Frequency[MHz] 16.5 -
Fine Baud Rate[Mbps] 2.00 - m
Hot Plug Mo =
4 Power
Power Target From The Emulator (MAX 200n Mo M Od |fy to be NO .
Supply Voltage 33V -
4 CPU Operating Mode
Register Setting Single Chip
Mode pin Single-chip mode -
4 Communication Mode
Mede Debug Made an
Execute The User Program After Ending The [ Mo - -
] m b
Appl Revert
Filter matched 9 of 13 items l By ] [ =
- .
@ [ oo JJi—= - Click here.
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5. When the following message is displayed, click Yes.
Confirm Perspective Switch @

This kind of launch is configured to open the Debug perspective when it suspends,

This Debug perspective is designed to support application debugging. It
incorporates views for displaying the debug stack, variables and breakpoint
management,

Do you want to open this perspective now?

"] Remember my decision

Click here.

6. When the load module download completes, a Debug perspective opens.

&7 Debug - led_sample/r_bsp/board/rsknddm/resetprg.c - &2 studio | =3 ECR()|
File Edit Source Refactor MNavigate Search Project Run  Window Help
B [ B - K- N FOH-C- - Nk EHE S i i Nrm i 2 ol Hn e | Y Quick Access || B | Boce+ (35 Debug
%5 Debug 52 Opv % @ &8I T = O 0= Variables 13 =g
4 [67 led_sample HardwareDebug [Renesas GDB Hardware Debugging] <% 0| ¢ E=E=2
4 5 led_samplex ] _ Name Type Value i
4 f® Thread [1]1 (No thread info availzble) (Suspended : Signal : SIGTRAP: Trace/breakpoint trap)
= PowerON_Reset_PC() at resetprg,c122 0ffc017e8
w1 gdb
o GDB server
[ resetprg.c 52 = 8 8= Outline 27 = B8
Once this tion is complete, the user's main() function is called. It should not return. . PELRE o % T
Arguments  : none . " "
* Return value : none U hclibh
e et 8 A 8 # BSP_DECLARE_STACK
ffcel7ed - void PowerON_Reset_PC(void) U platform.h
# PSW_init E
/* stack pointers are setup prior to calling this function - see comments above # PSWint
/* Initialize the Interrupt Table Register */ # FPSW.init
fco17f6 set_intb({void *)__ sectop("CSVECT")); ++ _INIT_I0LIB(void) : void
+ _CLOSEALLvoid): void
* Initialize the Exception Table Register 44 my_sw_warmstart_prec_function(void) : void
oL Set_extb((vaid *)_seciop(EXCEPTVECT)); i £ my_sw warmstart_poste function(void) : void
‘i v ++ PowerON_Reset_P oid .
E Console 57 | ¥ Tasks % Renesas Coverage Memory Usage (- Performance Analysis ( Profile 1% Real-time Chart @2 Trace ('} Visual Expression [Z Problems (3 Executables [J Memory =8
|GBEEE & e i
Ied sample HerdvareDsbug [Renssas GDE Herdvare Debugging] gdb
monitor set_io_access_width,Ri,1, d, d, 902b5-902bd, 902c6-902cd, 302ds -9024d, 90266-9022d, 9027690273, 90305-9030d, 90316-9031d,98326-9032d, 90336 -9033d, 963469034, 90.
monitor set_io_access_width,RW,1, 4. ,90376-9037d, d, b bd,903c6-983cd, 903d6-903dd, 983e6-903ed, 90376-903Fd, 90320-9883F, 9054890853, 98858, 91286 -91.
monitor set_: access_width,RW,1,91226-9122d,91236-9123d,91246-9124d, 91256-9125d 91266~ 9126d 91276-9127d,91286-9128d,91296-9129d,912a6-912ad,912b6-912bd, 912c6-912¢d, 912d6-912dd, 912e6-912ed, 91
monitor set_: ln access \fldth RN 1 91395 Eliﬂd 91316 913151 91325 913211 91336—9133&1 91346-9134d,91356-9135d,91366-9136d,91376-9137d,91386-9138d,91396-9139d,913a6-913ad,913b6-913bd, 913¢6-913¢cd, 91,

7. Click Restart on the toolbar. The program will be executed and a break will occur at the start of the main function.

Debug - led_sample/r_bsp/board/rskrfdm/resetprg.c - &2 studio
File Edit Source Refactor Mavigate Search Project Run  Window Help

o |19 -® - & F D50~ \[B—ae Click here.
%5 Debug 52 E%'%@@N|i‘=€>

4 [ led_sample HardwareDebug [Renesas GDB Hardware Debugging]

4 [ led_samplex
a f Thread [1]1 (Mo thread info available) (Suspended : Signal : SIGTRAP:Trace/breakpoint trap)
= PowerOM_Reset PC() at resetprg.c:122 Oxffc017e8
w gdb
p| GDB server

[] resetprg.c &2

8. After the break at the start of the main function, click Restart on the tool bar again.
The project will be run and the program will iterate toggling LEDO with a period of 0.5 seconds.
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435 For location of the API information of each FIT module
For the API information of FIT module embedded in the project, refer to the doc folder of each FIT module folder.
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5. RX Driver Package Application

5.1 RX Driver Package Application Structure

The RX Driver Package Application is a sample application program provided so that users can use the RX Driver
Package easily. The RX Driver Package Application consists of an application program that operates using device
drivers and middleware included in the RX Driver Package and a project file for building that application. This allows
users to start evaluation quickly.

RX Driver Package Application

' Sample appllcatlon program I | !rolec!”e l

Figure 5-1 RX Driver Package Application Structure

Renesas plans to release a variety of types of this RX Driver Package Application in the future, such as system
programs that operate using a combination of multiple drivers and middleware and evaluation programs for independent
modules from the RX Driver Package.

For information of the latest RX Driver Package Application, refer to the “Products Supporting RX Driver Package
Application” shown in the following URL.

http://www.renesas.com/products/mpumcu/rx/child/fit.ijsp

Network server

andiciiz Camera control program Audio player (ADPCM)

Device driver evaluation Image and video

Boot loader middleware control
program program
Boot loader RX Driver Package
Application
Figure 5-2 Types of RX Driver Package Application
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6. Supplement

6.1 Commercial Version of Middleware and Drivers Supporting FIT
A list of the commercial version (paid) Middleware and Drivers for RX family is shown below.

For the information of the latest commercial version (paid) Middleware and Drivers, refer to the page of the
Middleware and Drivers shown in the following URL.

Page of Middleware and Drivers: http://www.renesas.com/mw/

Table 6-1 list of the commercial version (paid) Middleware and Drivers for RX family

Commercial Version URL FIT
Compliant

TCP/IP for Embedding http://www.renesas.com/mw/t4 Available

M3S-T4-Tiny
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Website and Support

Renesas Electronics Website
http://www.renesas.com/

Inquiries
http://www.renesas.com/contact/

All trademarks and registered trademarks are the property of their respective owners.
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General Precautions in the Handling of MPU/MCU Products

The following usage notes are applicable to all MPU/MCU products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that
have been issued for the products.

1.

Handling of Unused Pins

Handle unused pins in accord with the directions given under Handling of Unused Pins in the manual.

— The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin
in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an associated shoot-
through current flows internally, and malfunctions occur due to the false recognition of the pin state as an
input signal become possible. Unused pins should be handled as described under Handling of Unused Pins in
the manual.

Processing at Power-on

The state of the product is undefined at the moment when power is supplied.

— The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are
undefined at the moment when power is supplied.
In a finished product where the reset signal is applied to the external reset pin, the states of pins
are not guaranteed from the moment when power is supplied until the reset process is completed.
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function
are not guaranteed from the moment when power is supplied until the power reaches the level at
which resetting has been specified.

Prohibition of Access to Reserved Addresses

Access to reserved addresses is prohibited.

— The reserved addresses are provided for the possible future expansion of functions. Do not access these
addresses; the correct operation of LSI is not guaranteed if they are accessed.

. Clock Signals

After applying a reset, only release the reset line after the operating clock signal has become stable.
When switching the clock signal during program execution, wait until the target clock signal has
stabilized.

— When the clock signal is generated with an external resonator (or from an external oscillator) during a reset,
ensure that the reset line is only released after full stabilization of the clock signal. Moreover, when
switching to a clock signal produced with an external resonator (or by an external oscillator) while program
execution is in progress, wait until the target clock signal is stable.

. Differences between Products

Before changing from one product to another, i.e. to a product with a different type number, confirm

that the change will not lead to problems.

— The characteristics of an MPU or MCU in the same group but having a different part number may differ in
terms of the internal memory capacity, layout pattern, and other factors, which can affect the ranges of
electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of
radiated noise. When changing to a product with a different part number, implement a system-evaluation test
for the given product.




Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for

the incorporation of these circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from the

use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics does not warrant that such information is error free. Renesas Electronics

assumes no liability whatsoever for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of third parties by or arising from the use of Renesas Electronics products or

technical information described in this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or

others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Electronics assumes no responsibility for any losses incurred by you or

third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The recommended applications for each Renesas Electronics product depends on

the product's quality grade, as indicated below.

"Standard": Computers; office equipment; commt ns ; test and it ; audio and visual equipment; home electronic appliances; machine tools; personal electronic

equipment; and industrial robots etc.

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-crime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical
implantations etc.), or may cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality grade of each Renesas Electronics product before using it
in a particular application. You may not use any Renesas Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable for any damages or losses

incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, especially with respect to the maximum rating, operating supply voltage

range, movement power voltage range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or damages arising out of the

use of Renesas Electronics products beyond such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and
malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to guard them against the
possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including but not limited to

redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult,

please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please use Renesas Electronics

products in compliance with all applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive. Renesas Electronics assumes

no liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or
regulations. You should not use Renesas Electronics products or technology described in this document for any purpose relating to military applications or use by the military, including but not limited to the

development of weapons of mass destruction. When exporting the Renesas Electronics products or technology described in this document, you should comply with the applicable export control laws and

regulations and follow the procedures required by such laws and regulations.
10.

o

contents and conditions set forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of unauthorized use of Renesas Electronics

products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) "Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise places the product with a third party, to notify such third party in advance of the
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